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Introduction 
Excel is a spreadsheet program. A spreadsheet, also called a worksheet, is an important 
business tool that helps to analyze and evaluate information. Worksheets are often used 
for maintaining lists, budgets and financial reporting, inventory management, cost 
estimating, and interactive forms.  
 
This manual will outline many tasks that you will need to perform to complete various 
assignments that you will receive as a student here at The University of Akron. The tasks 
discussed in this manual are: 

◘ Creating a New Spreadsheet 
◘ Opening an Existing Spreadsheet 
◘ Save As 
◘ Creating a Folder 
◘ Sorting and Maintaining Lists 
◘ Creating Formulas 
◘ Using Functions 
◘ Formatting Worksheets 
◘ Inserting a Page Break 
◘ Using Comments 
◘ Inserting Charts 
◘ Using Help 
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Getting Started 
 
Creating an Excel Workbook 
 
You will create and enter data into a worksheet.  The image below shows the basic 
elements of a worksheet. 

  
 
The document window, usually called the work window, contains the workbook that 
you are using. When a new workbook is started in Excel, there are three worksheets. 
Worksheets may be added or removed from the workbook. 
 
Each worksheet in the workbook consists of a series of columns and a series of rows. 
Columns are assigned alphabetic labels from A to IV (256 columns). Rows are assigned 
numeric labels from 1 to 65,536 (65,536 rows). This means that there are 16,777,216 
cells in each Excel worksheet. 
 
A cell is the rectangular area where a column and a row intersect. Each cell is identified 
by a cell reference, such as A1, which is its column and row location. The active cell is 
the cell in which you are currently working. Excel identifies the active cell with a dark 
border that outlines one cell. In the example above, C4 is the active cell. 
 
 

Formula Bar 
Menu Bar 

Name Box 

Worksheet 

Active Cell 

Sheet Tabs 

Task Pane 
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Editing Cells 
 
If it is necessary to change the contents of a cell, or clear the contents of the cell, follow 
these instructions. 
 
To clear the contents of a cell,  click in that cell to make it the active cell and press 

the Delete key on your keyboard. 

To replace the contents of a cell,  click in that cell to make it the active cell and type 
over the existing contents.   

To edit the existing contents,  double-click inside the cell. The insertion point will 
appear within the cell. Then, use the arrow keys on 
the keyboard to position the insertion point where 
needed and make the change. 

To remove the formatting in a cell, click on Edit, Clear, Formats from the menu. 

Using the Formula Bar 
 
Below the standard and the formatting toolbars is the formula bar, which displays the 
contents of the active cell. A cell’s contents are the text, numbers, or formulas that you 
enter into it. As you type or edit data, the changes appear in the formula bar. 
 
When a formula is entered into a cell, the formula bar contains the formula, not the 
results of the formula which are displayed in the worksheet. 
 

   
 
In the above picture, you see the sum of the cells G3 through G12 in cell G13. That is the 
result of the formula. In the formula bar, the formula is displayed, which is the actual 
contents of cell G13. 
 
If the values in cells G3 through G12 are changed, Excel automatically will recalculate 
the sum and display the new results in cell G13. 

The contents of the 
cell are displayed in 
the Formula Bar. 

The results of the 
formula are displayed 
in the cell. 
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Inserting Rows and Columns 
 
To insert a row or column into a worksheet, position the insertion point anywhere in the 
row or column where the new row or column is to be inserted. From the menu, click on 
Insert, Rows or Columns. Alternatively, right click on the column or row header. From 
the shortcut menu that appears, select Insert. 
 

    
 
In the example above, a column will be inserted between COLUMN C and COLUMN D. 
 
 
Customizing the Display of the Formatting and Standard Toolbars 
 
To display the toolbars on two separate rows, follow these steps: 
1. From the menu, click on Tools, Customize. The Customize dialog box is displayed. 
2. Click on the Options tab. 
3. Click to place a checkmark in the box, Show Standard and Formatting toolbars on 

two rows. 
4. Click on the  button. 

 
 

Place a checkmark 
in the box for 
Always show full 
menus. 
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Step by Step - Create a New Workbook and enter Values and Labels 
 

What you do What happens 
1. To start Excel, click on Start, 

Programs, and Microsoft 
Excel. 

Excel is opened and a new workbook is opened. 

 
 
On the right side of the work window is the task pane. It 
can be closed with its X or View, Task Pane from the 
menu. View, Task Pane can be used to display the task 
pane if it is not displayed. 

2. Click in cell A2 to make it the 
active cell. 

3. Type Abel. 
4. When finished with your typing, 

press the Enter key on the 
keyboard. 

5. In cell A3, type Baker.  
6. Press the Enter key. 
7. Complete the typing in column 

A as shown. 

The entries for column A are completed. 

 
 
NOTE: When you press Enter, two things occur. 
Excel knows that you are done with your typing and 
the active cell becomes the cell that is down one row. 
 
You may use other keys to tell Excel that you are 
done typing and move into another cell. The Tab key 
on your keyboard moves to the next cell to the right. 
Shift + Tab moves to the next cell to the left. The 
arrow keys move in the direction of the arrow. 
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What you do What happens 
8. Click in cell B1 to make it the 

active cell. 
9. Type January.  
10. Press the Tab key or the right 

arrow key to move to cell C1. 
11. Type the entries for cells C1 

through E1. 
12. Be sure to press the Enter key 

to complete your entry in cell 
E1 

The entries for cells B1 through E1 are completed. 

 
 
The contents of cells A2 through A4, A6 and cells 
B1 through E1 are labels. To Excel, there are two 
basic types of content, content used for calculation 
(value) and content not used for calculation (label). 
By default, Excel will align labels on the left side of 
the cell. 
 

13. Click in cell B2 to make it the 
active cell. 

14. Type the numbers in cells B2 
through B4. 
 
You may want to use the 
numeric keypad, on the right 
side of your keyboard, to enter 
the numbers. 

The entries for cells B2 through B4 are completed. 

 
 
The contents of cells B2 through B4 are values. Values 
are content used for calculation. The value may be a set of 
digits or a formula. By default, Excel will align values on 
the right side of the cell. 
 

15. Click in cell A4. 
16. Type Charles. 
17. Click on the Enter  tool on 

the Formula bar. 

The contents of the cell are replaced with the label, 
Charles. 
 
The Enter tool is used to complete an edit and remain 
in the current active cell. 
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What you do What happens 
18. Click in the Formula Bar after 

the word Charles to place the 
insertion point.  

19. Backspace to erase the es in 
Charles. 

20. Type ie to change the name to 
Charlie. 

21. Click on the Enter  tool. 

The label Charles is changed to Charlie. 
 

 
 

22. Press the Delete key on the 
keyboard. 

The contents of the active cell are deleted. 
 

23. Click on the Undo  tool on 
the standard toolbar. 
 

The contents of the cell are undeleted. 

24. Double click in cell A4 to place 
the insertion point inside the 
cell. 

25. Use the arrow keys to move the 
insertion point, if necessary, and 
erase the ie and replace it with 
es. 

26. Click on the Enter  tool. 
 

The label Charlie is changed to Charles. 

27. Click on the Bold  tool. The contents of the cell are in bold type. 

28. Press the Delete key on the 
keyboard. 

29. Type your name. 
30. Click on the Enter  tool. 

The delete key erases only the contents of the cell. 
The contents of the cell are changed to your name. 
The formatting (bold) remains. 

 
 

31. From the menu, click on Edit, 
Clear, Formats. 

The formatting (bold) is removed from the cell. 
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What you do What happens 
32. To insert a column for April, 

click on the column heading for 
column E to select that column. 

33. From the menu, click on Insert, 
Columns.  
 

Column E is selected and the Insert menu is 
displayed, before you click on Columns. 

 
 
After you click on Columns in the Insert menu, a 
column is inserted at column E. All columns of data, 
from the selected column, E, and forward, are moved 
one column to the right. 

 
 

34. To insert a row, click on the 
row header to select that row. In 
this example, click on the row 2 
header. 

35. From the menu, click on Insert, 
Rows. 

A row is inserted at row 2. All rows from the selected 
row, 2, and greater are moved one row down. 

 
 
NOTE: To insert more than one row or column, select 
more than one by dragging through the headers. 
Then, from the menu, click on Insert, Rows (or 
Columns). 
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What you do What happens 
36. To delete a row, click on the 

row header. In this example, 
click on the row 2 header. 

37. From the menu, click on Edit, 
Delete 

The row is deleted. 
 
NOTE: The same procedure can be followed to delete 
a column. Select the column by clicking on its 
header. From the menu, click on Edit, Delete. 
 
ALTERNATIVE PROCEDURE: Place the mouse 
pointer over the row or column header and right 
click. From the shortcut menu that appears, click on 
Delete. 

 
 

38. To save your spreadsheet, click 
on the Save  tool in the 
standard toolbar. 

39. In the Save As dialog box, at 
Save In, select the disk and 
folder in which to save your 
work. 

40. In the File name area of the 
dialog box, type in Sales 
Figures XXX where XXX are 
your initials. 
Ex: Sales Figures PKR 

41. Click on the Save button that is 
inside the dialog box. 

The Save As dialog box 

 
 
Your worksheet is saved as Sales Figures XXX in 
the folder you chose. The filename is displayed in the 
title bar of your Excel work window. 
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What you do What happens 
42. Click on File, Close in the 

menu. 
The work window is closed and the application 
window for Excel remains open. 

 
 

   
 
 
 
 
 
 
 

TIP: To enter a fraction, such as 1/8, type a zero and a space, then type 1/8. The zero and a 
space tell Excel that this is a fraction and not a date. 
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Step by Step - Open an Existing Workbook 
What you do What happens 

1. From the menu choose: 
File, Open 
 

The Open box displays. 

 
2. Locate the file and select it by 

clicking one time with the left 
mouse button.  
 
Click on the Open button. 
 

The file opens in Excel. 
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Save As 
After you create a new workbook, you will need to save the file with a name.  When you 
are saving documents it is a good practice to store your documents in folders.  After you 
create folders, you can sort and store your Excel workbooks in an organized manner that 
will allow for easy retrieval of your work. 
 
Definitions 
Word Definition 
Save As Save As allows you to save a file with a new name, extension, or 

location. 
 

 
Step by Step - Use Save As  

What you do What happens 
1. From the menu choose: 

File, Save As 
The Save As box displays. 

 
 

2. To change the location of the 
file, use the down arrow in the 
Save in field to find the new 
location. 
 
In the File name field, enter a 
name for the file. 
 
Leave the Save as type field as 
Excel Workbook (.xls).  
 

 

3. Click on the Save button. 
 

 

4. You can also use the Save  
button on the Standard toolbar. 
 

Note:  You only get the Save As box if that is the 
first time you save the file.  
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Step by Step - Create a New Folder  
What you do What happens 

1. From the menu choose: 
File, Open 
OR 
File, Save As 
 
 
Note:  If you are starting a new 
project and you are working on a 
new file you will most likely use 
the option of File, Save As (this 
will allow you to save the file and 
create a new folder at the same 
time). 

The Open box or Save As box displays. 

 
 

2. Go to the location where you want 
the new folder to be placed.   
 
For example, if you want the folder 
to be at the root of My Documents, 
be sure the Look in field (or Save 
in field) says My Documents.  
 

 

3. Click on the Create New Folder 

button  at the top of the box. 
 

The New Folder box displays. 

 
 

4. Enter a name for the new folder. 
 
Click on the OK button. 
 

The new folder is named and it is now open. 

 
 

5. You can now save files in the new 
folder  for better organization. 
 

 



Excel 2003  The University of Akron 

 
Ver. 2005.11.30 Page 16 Information Technology Services 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

Sorting and Maintaining Lists 
 
Discussion 
One use of a worksheet is to manage lists of data, such as student lists, phone lists, and 
budget transaction lists. Using Excel, you can store and update data, sort data, search for 
and retrieve data, summarize and compare data, and create reports. 
 
In Excel, a list is a collection of similar data stored in a structured manner, in rows and 
columns. In the example below, the worksheet shows a portion of a faculty list. Within an 
Excel list, each column represents a field that describes some attribute or characteristic of 
an object, person, place, or thing. When related fields are grouped together in a row, they 
form a record, a collection of fields that describes a person, place, or thing. For example, 
the data for each student-first name, last name, department, rank, graduation year, and 
sex-represents a record.  A collection of related records makes up an Excel list. 

 
KEY IDEA: Excel has rules for managing lists. If your data follows the rules, Excel 
will function as noted in this lesson. 

A. Within the rows of data, there are no blank rows and no blank columns. A 
null field value (a field with no value) is allowed. However, a row with no 
record or a column with no field values and no field name is not allowed. 

B. The row directly above the first row of data contains the field names. 
 
Before creating a list, you will want to do some planning. As you think about how you 
will use the list, consider the types of reports, queries, and searches you may need. This 
process should help you determine the kind of information to include for each record and 
the contents of each field. 
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Step by Step – Use the Create List Command1 
What you do What happens 

1. Click on the Open  tool in 
the standard toolbar, or click on 
File, Open from the menu. 

2. Locate the workbook you wish 
to open. 

 

 
 

3. Click in any of the cells within 
the list. 

 

 
 

4. From the menu, click on Data, 
List, Create List. 
 
Alternatively, you can press 
CTRL + L . 

The list is identified by the "marquee" and the Create 
List dialog box is displayed. The data range for the 
list is given (as absolute cell references) and the box 
is checked for "My list has headers." 

 
 

                                                 
1 The Create List command cannot be used in a workbook that is being shared.  You must remove the 
workbook from shared use first, use Create List and then share the workbook, again. 
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What you do What happens 

5. Click on OK. Note the following: 
a. The list is highlighted in the worksheet.  
b. The AutoFilter arrows  are displayed in the 

cells of the header row. 

 
c. The List toolbar is displayed. (If it does not 

display, select View, Toolbars, List from the 

menu.)  
A special, blank row is included in the list range at the end 
of the list. The row has an asterisk in the first column to 
indicate that it is the Insert Row. 

 
6. Click in any cell inside the list 

to remove the highlighting and 
keep the list active. 

The list is surrounded by a dark blue border. 
 
NOTE: If you click in a cell outside of the list, the 
list's border becomes less prominent and the auto 
filter arrows are not displayed. The list is deactivated. 
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Freeze Panes 
In larger worksheets, where all the data can not be displayed on a single screen, scrolling 
vertically or horizontally can remove rows of labels or columns of data that are necessary 
to identify the records. Without these rows or columns for identification, the data has 
little meaning. The Freeze Panes command allows you to maintain the display of certain 
rows and/or columns of data when you scroll. 
 
Step-by-Step – Freeze Panes 
 

What you do What happens 
1. Use the vertical scroll bar on the 

right side of the work window to 
scroll down a few rows. 

Note that the row of field names has 
scrolled from view. It is difficult to identify 
the type of data that is stored in each 
column. 

 
 

2. Use the horizontal scroll bar on the 
bottom left side of the work window 
to scroll left a few columns. 

The data stored in the first columns, 
LastName and FirstName, identifies the 
record. Without the names, the remaining 
data has little meaning. 
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What you do What happens 
3. Press Ctrl + Home to return to cell 

A1. 
4. Use the following guidelines to lock 

rows and/or columns: 
 To lock rows, select the row 

below where you want the split 
to appear.  

 To lock columns, select the 
column to the right of where you 
want the split to appear.  

 To lock both rows and columns, 
click the cell below and to the 
right of where you want the split 
to appear. 

Note that the rows needed for identification 
are above the active cell. The columns 
needed for identification are to the right of 
the active cell. 
 

 

 
 
In this particular example if we wanted to 
always see the data in the Lastname and 
Firstname columns and the field names, we 
would need to click on cell C3.   The rows 
needed for identification are above the 
active cell (C3). The columns needed for 
identification are to the right of the active 
cell (C3). 
 

5. In the menu, click on Window, 
Freeze Panes. 

Lines are displayed below row 2 and 
between columns B and C. The rows above 
the active cell are frozen. The columns to 
the left of the active cell are frozen. 

6. Scroll down in the worksheet. 
7. Scroll to the right in the worksheet. 

Rows 1 and 2 remain displayed. Columns A 
and B remain displayed. 

 
 

8. From the menu, click on Window, 
Unfreeze Panes to return to normal 
viewing. 

The worksheet scrolls without columns or 
rows frozen in place. 
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Step by Step -  Sort Data 
 
To sort data in an Excel list, click on the AutoFilter arrow for the column by which to 
sort. You also may use the Data, Sort command in the menu. 
 

What you do What happens 
1. To sort an Excel list by one field: 

a. Click on the AutoFilter arrow for 
the column by which to sort.  

b. Select Sort Ascending or Sort 
Descending from the choices 
that appear. 
 
The Sort choices are at the top of 
the AutoFilter list. 

The list is sorted by the values in the 
GradYear field. Excel knows to keep the 
records together.  

 
 

 
KEY IDEA: You do not need to 
select (highlight) any of the 
columns, rows, or cells yourself.  
  

2. To sort an Excel list by more than 
one field: 
a. The active cell should be within 

the list. 
b. In the menu, click on Data, Sort. 
c. In the Sort dialog box, select the 

primary sort field. Then, if 
several records have the same 
value in that field, indicate the 
secondary sort field. You may 
sort by a tertiary field, as well. 
 
In this example, sort by 
Department in Ascending order, 
and then by LastName in 
Ascending order. First, Excel 
will group and sort the records 
by Department. Second, within 
each Department, Excel will sort 
the records by LastName. 

The Sort dialog box is displayed with your 
choices. 

 
 



Excel 2003  The University of Akron 

 
Ver. 2005.11.30 Page 22 Information Technology Services 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

What you do What happens 
3. Click on OK. The list is sorted as you specified. 
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Filter Lists 
 
The Excel AutoFilter feature allows you to filter the data to view only the records that 
meet certain criteria. The records that do not meet those criteria will be hidden from 
view. For example, you could ask to see only the records for the females in the 
Accounting Department, as shown here. 
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Step by Step -  Filter Lists using AutoFilter 

What you do What happens 

1. Click in any cell in the list.  
 
The active cell should be a cell in 
the list to display the AutoFilter 
arrows. 

A down arrow appears in each of the header row 
cells. 

 
 
The down arrows are displayed on the screen, but they do 
not print. 

2. Click the AutoFilter arrow  to 
the right of the column label and 
select the filter criteria from the 
drop-down list. You may click the 
AutoFilter arrow on multiple fields 
to filter on additional criteria.   

3. In our example (selecting all 
Females within the Accounting 
Department:  

a. Click on the down arrow 
for the field named 
Department and click on 
the field value, 
Accounting.  
 

Only the records that have an F as the field value in 
the Sex field and Accounting in the Department field 
are displayed. All the other records are hidden. 

  
 

 
 
NOTE: When a list is filtered, Excel will change the 
color of the row numbers to blue to indicate that 
some rows of data are hidden. Also, a note appears in 
the left side of the status bar to indicate the number of 
records displayed and the total number of records in 
the list. 
 
If you filter one list and the worksheet has another list, the 
other list may not display fully. When AutoFilter hides a 
row, the row is hidden in its entirety. 

4. To display all the records in the 
list, click on Data, Filter, Show 
All in the menu. 
 

All the records in the list are displayed. 
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What you do What happens 

5. To remove the AutoFilter arrows, 
click on Data, Filter, AutoFilter 
(which removes the checkmark on 
AutoFilter). 

The AutoFilter down arrows are removed from the 
display. 
 
 

6. To display the AutoFilter arrows, 
again, click on Data, Filter, 
AutoFilter (which places a 
checkmark on AutoFilter. 

The AutoFilter down arrows are displayed. 

 
NOTE: In any column (field) of a list, if there are cells with no entries (blanks), two 
additional choices are added to the AutoFilter drop-down list for that column – Blanks 
and NonBlanks. Select Blanks to see only the records without an entry in that column. 
Select NonBlanks to see only the records with an entry in that column. 
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Step by Step - Filter a List Using a Custom Filter 
 

What you do What happens 
1. Click in any cell within the list to 

display the AutoFilter arrows. 
 
 

The list is active. 

2. Click on the AutoFilter arrow for the 
field to be filtered. 
 
 

 

3. Click on (Custom…). The Custom AutoFilter dialog box is 
displayed. 

 
4. You can click the first down arrow 

under the field name and select the 
appropriate criteria (equals, does not 
equal, is greater than, etc.)from the 
list that displays.  Next, enter your 
desired criteria in the box on the 
right. 

 

The criterion that you entered is displayed. 
GradYear is greater than 1976. 
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What you do What happens 
5. Click OK. The list is filtered based on the criterion that 

you entered. 

 
6. From the menu, select Data, Filter, 

Show All. 
The filter is removed and the entire list is 
displayed. 
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Step by Step - Use the Total Row in a List 
 

What you do What happens 
1. Click in any cell of the list. 

 
 

The active cell is within the list. 

2. From the List toolbar, click on the 
Toggle Total Row tool. 

. 
 
Alternatively, click on Data, List, 
Total Row in the menu. 

A Total Row is added at the bottom of the 
list, below the Insert Row. The last column 
is totaled.  

 
 

The Toggle Total Row tool will 
sum the entries in the last column 
of the list if the entries are 
numeric. It will count the entries 
in the last column of the list if the 
entries are not numeric. 

3. In this example, the ### displayed in 
D15 indicates that the D column is 
not wide enough to display the entry.
 
Increase the width of the D column 
by placing the mouse pointer on 
the boundary line between the D and 
E columns in the column header. 
Drag to the right. 

The total for the last column of the list is 
displayed. 
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What you do What happens 
4. If you click in the cell for the total 

(D15 in this example), the formula 
will display in the Formula bar. 
 
Note the formula that Excel created 
in cell D15: 
SUBTOTAL(109,D3:D13) 

 
 

The formula bar 

 
 

5. A down arrow appears on the right 
side of the cell. Click on the down 
arrow to select a different function 
from the shortcut menu that appears. 

The shortcut menu 

 
 
After you select a function from the menu, 
Excel writes a new formula using that 
function. When you save the workbook, the 
formula that is present is saved. 

In the formulas created in the Total 
Row, there is a number such as the 
109 that you see circled here. The 
number stands for a function name: 
Number Function Name 

101 = Average 
102 = CountNums 
103 = Count 
104 = Max 
105 = Min 
107 = Standard Deviation 
109 = Sum 
110 = Variance 
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What you do What happens 
6. Click on the down arrow to select a 

function or to select NONE. 
 

 
7. Turn off the Total Row by clicking 

 on  again. 

The Total Row no longer displays. 
 
 

8. Display the Total Row by clicking 

on  . 

The Total Row is displayed. 
If you toggle the row on again, the formula 
will be the one that you selected previously. 
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Step by Step - Split Text from Once Cell to Two or More Cells  
 

  
   

A worksheet may have text values in a single cell that you want to split into two or more 
cells. Let us use the above example and split the FullName into LastName and FirstName 
and Middle Initial, from one column of data to three columns of data. 
 
 

What you do What happens 
1. Insert the number of blank 

columns needed.  
a. Position the insertion 

point anywhere in the 
column where the new 
column is to be inserted. 

b. From the menu, click on 
Insert – Columns.  

In this example, we need to insert two columns for 
FirstName and MiddleInitial. 
 

 
 
 

2. Select the cells that contain the 
text to be split. 

We have selected cells A2:A4 which contain the 
FullName (which we want to split into multiple 
cells). 
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What you do What happens 
3. From the menu, select Data, 

Text to Columns.  The Convert 
Text to Columns Wizard is 
displayed. 

The Convert Text to Columns Wizard:  

 
 

4. Select the Delimited option 
button. 

5. Click on Next. 

Step 2 of the Wizard appears: 
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What you do What happens 
6. Select the delimiter (character) 

that separates the sections of the 
text. The delimiter is the 
character where you want to 
split the text.  

 
In this example, it is the comma 
(separating the last name from the 
first name and the space (separating 
the first name from the middle 
initial). The preview area indicates 
how the text will be separated. 
7. Click the Next button. 
 

The space and comma are used as the delimiters for 
this example:  

8. In Step 3, make any changes in 
cell formats that you want. 

 

We will not make any changes to the cell formats. 

9. Click on Finish. The contents of the active cell are deleted. 
 

10. The text has been split into 
multiple cells. 

 
Note:  You could then add column 
headings for the two new columns 
(FirstName and MiddleInitial).  

The worksheet appears as follows: 
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Creating Formulas 
One of many reasons to use a spreadsheet program like Excel is the program’s ability to 
do calculations and recalculations, when the values change. Formulas make your 
spreadsheets more versatile and hard working. 
 
Excel offers several timesaving methods for creating and using formulas. AutoSum is 
available to add rows and columns of numbers. Functions make it easier to perform 
routine and not-so-routine calculations. AutoCalculate allows you to see the answer to 
frequent mathematical calculations without creating a formula. 
 
In this lesson, you will review ways to create and use formulas in Excel worksheets. 
 
Terms to Know 
Formula A formula is a mathematical equation that calculates new values from 

existing values.  

Value A value is a number. The number may be a number you typed or a number 
that results from the calculation of a formula. 

Operators Operators are mathematical symbols used to perform calculations in 
formulas.  Some standard operators used in Excel are:  
 +  addition > greater than 
 -   subtraction < less than 
 *  multiplication = equal to 
 /   division & concatenate 

Cell Reference A cell reference, or cell address, identifies a particular cell, such as cell 
D12. Cell D12 would be at the intersection of column D and row 12. Cell 
references are used in formulas to indicate where a value is stored. 

Order Of 
Precedence 

The order of precedence is the order in which Excel calculates a formula. A 
suggested acronym to help remember the order of precedence is PEMDAS, 
Please Excuse My Dear Aunt Sally. 

PEMDAS PEMDAS represents the order is which the calculations are performed in a 
formula. In each step, Excel will begin at the left of the formula and move 
to the right, as you would read a sentence. 
 
Parentheses – All calculations inside parentheses are performed first. 
Exponents – All values with exponents are calculated. 
Multiplication and Division – Any multiplication or division is performed. 
Addition and Subtraction – Any addition or subtraction is performed. 
 
After the above operations, Excel will perform concatenation (indicated by 
an &). Then, Excel will perform the operations of equal to (=), less than (<) 
and greater than (>). 
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Part A: Formulas 
 
Formulas are mathematical equations that calculate new values from existing values.  
They allow you to use symbols called operators to add (+), subtract (-), multiply (*), and 
divide (/) numbers. In Excel, each formula should begin with an equal (=) sign. The 
equal sign tells Excel that everything in the cell is part of a formula. 
 
Formulas can contain more than just numbers.  They can also contain cell references.  For 
example, if you type =B7+C7, Excel will add the values in cell B7 and cell C7.  Using 
cell references instead of numbers is usually the best method to use for formulas because 
Excel automatically recalculates formulas if the value in a cell changes. 
 
Some formula examples are: 
 =B7+C7+D7+E7 Sums the values of the 4 cells 

 =sum(b7:e7) Sums the values of the 4 cells 

 =g64-g65   Subtracts the value in g65 from the value in g64 

 =(e200/12) *.15  Divides the value in e200 by 12. 
Then multiplies that answer by 15 
 

 =(f24*c10)-(f25*c10) First, multiplies the value in f24 by the value in c10 
Second, multiplies the value in f25 by the value in 
c10 
Then subtracts the second value from the first value 

 
 

 
 
 

The light bulb appears to indicate a tip for working with Excel. 
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Step by Step - Type Formulas to Add Values and Use AutoSum 
 

 What you do What happens 

1.  To open a file, click on the 

Open tool  or choose 
FILE, OPEN from the menu. 

Returns the Open dialog box. 

2.  Click in cell you wish to add 
a formula for.  

Places the insertion point in the cell.  

3.  Type the formula, starting 
with the equal sign. 
For example: 
 =b4+c4+d4 

Excel uses color borders to indicate the 
cells that are referenced in the formula. 
If you cannot see color, the borders 
still are helpful to verify that the 
formula is correct. 

 
4.  Click on the Enter  tool in 

the formula bar. 
Tells Excel you have completed your 
entry for that cell and keeps cell E4 as 
the active cell. Excel will calculate 
using the formula and display the 
formula answer in the cell as a value. 

5.  Check your formula in the 
formula bar for accuracy. If 
changes need to be made, 
click in the formula bar to 
place the insertion point and 
make the changes. Then, click 
on the green check mark . 

You check for accuracy.  

 

6.  To use the AutoSum tool, 
click in the cell you wish to 
add the formula for.  

Places the insertion point in the cell. 
 

=b5+c5+d5 
and 
=sum(b5:d5) 
are the same 
calculation. 

 
When you enter a 
formula in a cell, the 
content of the cell is 
the formula. The 
value you see (the 
answer to the 
formula) is displayed, 
but is not the 
contents of the cell.
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 What you do What happens 

7.  Click on the  

AutoSum  tool. 

Excel types the formula to add the 
numbers, using the function sum. The 
formula you see is  
=sum(b4:b9). 

 
Note that Excel  draws a “marquee” 
around the cells that are included in the 
formula. 

8.  Click on the Enter  tool in 
the formula bar to accept the 
formula that AutoSum typed. 

You accept the formula as correct. The 
marquee disappears and the formula is 
entered in the cell. 

9.  Sometimes, the “marquee” 
area that Excel has selected as 
the cells to include in the 
formula are not the correct 
cells.  You can change the 
marquee area and select the 
appropriate cells. 

Click on the AutoSum  
tool. 

Excel does not select the group of cells 
that you want to add. 

10.  With the mouse pointer as a 
white cross, drag across cells 
that you wish to be included 
in the sum.  In this example, 
we want to select cells B5 
through D5. 

Excel revises the formula to sum the 
values in the cells that you selected. 

 

11.  Click on the Enter  tool in 
the formula bar to accept the 
formula that AutoSum typed. 

You accept the formula as correct. The 
marquee disappears and the formula is 
entered in the cell. 
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Part B: Learn About Functions 
 
Excel includes over 300 preset formulas called functions. Functions allow you to 
perform advanced calculations, such as finding the sum of a range of cells, averaging a 
series of values, or calculating the monthly payment for a loan. For help to create a 
formula that uses a function, click on the function tool  in the Edit/Formula toolbar, or 
use the Insert, Function command from the menu. In either case, the Insert Function 
dialog box is displayed. 

 
 
Functions consist of a name followed by one or more arguments in parentheses. 
Arguments are usually numbers or cell references, but they may also be text. Arguments 
can be quite complex, but in this course, you will be using simple ones like those in the 
function in step 10 of your previous exercise.  
 
Look at the parts of the formula that used a function in step 11. 
 
 
 
 
 
 
 
 
The basic syntax for a formula that uses a function has three parts: 

a. Equals sign 
b. Function name - The function SUM adds the group of values listed within the 

parentheses that follow. 
c. Argument, enclosed in parentheses - In this formula, you see the argument 

(B4:B9), which is read as B4 through B9. 
 

=SUM(B4:B9) 

Function name Argument 

 
When you enter a 
formula in a cell, the 
content of the cell is 
the formula. The 
value you see (the 
answer to the 
formula) is displayed, 
but is not the 
contents of the cell.

Use this box to 
search for 
suggestions of 
functions that apply 
to your needs. For 
example, you might 
type count 
students.  Then, 
click on Go. 

In the list of suggested 
functions, click on a 
function to see its 
description and syntax. 
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There are no spaces in a formula. This formula adds the values in cells B4 through B9. 
The answer to the calculation is displayed in the cell B10, where you placed the formula.  
Functions often include references to ranges. A range is a group of cells that all touch 
one another and form a rectangle in shape. In your example, B4:B9 is the range of cells to 
be added.  
 
A range reference consists of two cell references separated by a colon, such as C3:G18.  
C3 is the upper-left cell in the range and G18 is the lower-right cell in the range. A range 
reference includes all cells within the range. 
 
 
New Terms 
Function A function is a preset formula that performs calculations.  Functions 

consist of the function name followed by its arguments in 
parentheses.  Some common functions are the SUM, AVERAGE, 
MIN, MAX, and COUNT functions. 

Function Name The function name appears immediately after the equal sign.  It tells 
Excel which function to apply to the argument in parentheses. 

Argument An argument indicates the values or cells upon which a function 
will act.  Arguments are usually numbers or cell references, but 
they may also be text. 

Range A range is a group of cells. 

Range 
References 

A range reference is used in a formula or function to indicate a 
group of cells.  Range references consist of two cell references 
separated by a colon, such as C3:G18.  

Colon Symbol A colon symbol inserted between two cell references in a formula 
defines a range of adjacent cells.  It means “through,” as in saying, 
“cells C3 through G18.” 

Syntax The syntax of a function refers to the order of the function's 
arguments.  In some functions, the order of the arguments 
determines how Excel calculates the function. 

 



Excel 2003  The University of Akron 

 
Ver. 2005.11.30 Page 40 Information Technology Services 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

Step by Step – Type a Formula Using a Function 
 

 What you do What happens 
1.  Click inside the cell where 

you wish to add the function. 
Places the insertion point in the cell. 

2.  Type the function.  For 
example: 
=sum(b6.d6 

The function is typed to add the range 
of values in cells B6 through D6. 
 
Excel will change the period to a colon 
and will add the ending parenthesis. 

3.  Click on the Enter  tool in 
the formula bar. 

Tells Excel you have completed your 
entry for that cell and keeps cell E6 as 
the active cell. Excel will calculate 
using the formula and display the 
formula answer in the cell as a value.  

4.  Many times it is useful to 
copy a formula to save time 
and avoid typing the same 
formula multiple times.    
Place your mouse pointer on 
the file handle (small black 
square) in the lower right 
corner of cell which contains 
the formula you wish to copy 
(in our example, cell E6). 
When the pointer looks like a 
thin black cross, hold down 
the mouse button and drag 
down to the last cell where 
you want to copy the 
formula to (in our example, 
cell E10). 

Copies the formula from cell E6 to 
cells E7 through E10. This is called 
AutoFill. 
When a formula is copied down to the 
next cell in a column, Excel changes 
the formula by incrementing the row 
reference by one. In this example, 
=SUM(B6:D6) in cell E6 is copied to 
the next cell down as =SUM(B7:D7). 

5.  You can also select the cells 
to include in a function, rather 
than typing the cell 
reference(s) directly into the 
function. 
In this example, we will use 
the Average function.  Click 
inside the cell where you 
wish to add the function. 
Begin by Typing the 
function: 
 =average( 
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6.  Instead of typing the range (in 
our example E4:E9), use your 
mouse to select the cells 
E4:E9. 

Excel types the range reference for 
you. You do not need to type the 
ending parenthesis.  

7.  Click on the Enter  tool in 
the formula bar. 

Accepts the typing and displays the 
answer to the formula. 
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Part C: Use AutoCalculate 
 
The AutoCalculate feature on the status bar allows you to perform a function without 
inserting it into the worksheet. You can view the answer to common formulas without 
typing the formulas or including the formulas in your worksheet. The common functions 
that are available in AutoCalculate are: Average, Count, CountNums, Max, Min, Sum. 
 
Step by Step – Use AutoCalculate 
 

 What you do What happens 

1.  Select the cells you wish to 
autocalculate (average, sum, 
count, etc.).   

Selects the cells in the range.  

2.  Look at the Sum value on the 
status bar. 

Shows the sum of the selected cells in the 
AutoCalculate area on the status bar. 
 

 
 
 

      
3.  Right click the Sum value on 

the status bar. 
Opens the AutoCalculate menu. 
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 What you do What happens 

4.  Point to and click Min. Displays the minimum value in the 
AutoCalculate area on the status bar. The 
function Min finds the smallest value in the cell 
range. 

 
 
 

   
5.  Right click the Min value on 

the status bar. 
Opens the AutoCalculate menu. 

6.  Point to and click Max. Displays the maximum value in the 
AutoCalculate area on the status bar. The 
function Max finds the largest value in the cell 
range. 

 
 
     
      

   
 
 

A Reference Guide for Formulas is provided in the Appendix of this manual.  
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Formatting Worksheets 
 
The following techniques will assist you in creating professional looking spreadsheets. 
 
Step by Step - Format Numbers as Currency 
 

 What you do What happens 

1.  To format cells: 
First, select the cells. 
Then, right-click and choose 
Format Cells. 
OR 
From the menu, choose 
Format; Cells. 

The cells highlight.  The Format Cells 
dialogue box opens. 
 

 
2.  Click the Number Page. Opens the number page which lists 

number categories 

3.  Click Currency in the 
Category list box. 

Selects the Currency format and 
displays more options on the Number 
page. 
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 What you do What happens 

4.  To change the decimal place 
of the figure, use the Decimal 
Places field on the right side 
of the Number page.  Change 
the decimal place to “2.” 

Changes the selected information 
decimal place. 

5.  Click the OK button. Closes the dialog box and applies the 
Currency format to the selected cells, 
as shown in screen shot. 

6.  An alternative method would 
be to use the Increase 
Decimal or Decrease 
Decimal toolbar 

icon.  and the 

Currency Style icon . 

Changes the selected information 
decimal place.  

An example of formatted currency: 
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Step by Step - Format a Percentage 
 

 What you do What happens 

1.  To format cells: 
First, select the cells. 
Then, right-click and choose 
Format Cells. 
OR 
From the menu, choose 
Format; Cells. 

The cells will highlight and the Format 
Cells dialog box opens. 
 

2.  Click on the Number Page. Takes you to the number Page. 
 

 
 

3.  To format the number as a 
percentage, select Percentage 
from the Category list box. 
 

Selects the Percentage format and displays 
the option for decimal places on the right 
side of the page. 

 
4.  Change the decimal place 

field to zero. 
Default is set to 2 decimal places. 
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5.  An alternate would be to click 
the Percent Style icon on the 

toolbar  . 

Applies the new format to the cell, as 
shown in screen below. 

6.  Click the Save icon. Saves the workbook. 

An example of a formatted percentage: 
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Step by Step - Format Dates 
 

 What you do What happens 

1.  To format cells: 
First, select the cells. 
Then, right-click and choose 
Format Cells. 
OR 
From the menu, choose 
Format; Cells. 

The cells will highlight and the Format 
Cells dialog box will open. 

2.  Click on the Number page. Take you to the Number page. 

 
 

3.  Click Date in the Category 
list box, and then click on 
your choice from the Type 
list box. 

Selects the Date category, and then 
selects the new date format. 

 
4.  Click the OK button. Closes the dialog box and applies the 

change to the dates in the selected 
cells. 

5.  Click the Save icon. Reveals the worksheet, and then saves 
the workbook. 
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When the number sign is displayed across 
the cell, it means that the column is not 
wide enough to display the cells contents. 
Increase the column’s width. 
 
One way to increase the column’s width is 
to place your mouse pointer in the column 
header on the dividing line between the 
columns. When your mouse pointer is on 
the dividing line, it becomes a double-

headed arrow . Hold down the mouse 
button and drag the dividing line to the 
right, until you have the width you need. 
Then let go of the mouse button.  

 
An example of a change in the date format: 
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Step by Step - Align Text 

By default, Excel left-aligns text and right-aligns numbers, but you can change the 
alignment of any cell.  The contents can be left aligned, right aligned, centered, or 
justified.  You can also center the contents of a cell across an entire range of cells. 
 

 What you do What happens 

1.  Select the cells you want to 
format.  

The cells will highlight. 

2.  In the formatting toolbar, click 
on the icon for the type of 
alignment you want.  
left align, center, or right align. 
 

  

Per your selection, Excel 
will realign your selected 
cells. 

An example of the re-aligned cells: 

 

Right-aligned Centered Left-aligned
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Step by Step - Merge Cells and Center Text 
 

 What you do What happens 

1.  Select the cells you want to 
format.  

The cells will highlight 

2.  Click on the toolbar icon, 
Merge and Center, to merge 
the cells into one larger cell 
and then center the text 
within the larger cell. 

 
 
Note:  You can unmerge cells 
by clicking on the Merge and 
Center tool again. 

Per your selection, Excel will 
merge your selected cells. 

An example of merged cells with text centered: 
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Step by Step - Wrap Text within a Cell 
 

The Wrap Text option specifies that text in the selected cell will break into lines within a 
cell. 

 

 What you do What happens 

1.  Select the cells you want to 
format.  

The cells will highlight. 

2.  Right-click, then trace to and 
click Format Cells. 

Opens a shortcut menu, and then opens 
the Format Cells dialog box. 
 

 
3.  Click the Alignment Page. Opens the Alignment Page list. 

4.  Under Text Control, select 
the checkbox for Wrap Text. 

Selects the Wrap Text category. 

 
5.  Select OK Return to your spreadsheet, and your 

selection of cells will be using word 
wrap. 
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An example of unwrapped text: An example of wrapped text:  
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Step by Step - Change Font and Font Size 
 

 What you do What happens 

1.  Select the cells that you want 
to make a font change to. 
 

Highlights the cells. 

2.  Click the Font down-arrow 
on the Formatting toolbar, 
then scroll down and click 
Times New Roman or 
whichever font you want. 

 
 

Opens the Font list box, then 
scrolls down the list and 
changes the text to Times 
New Roman or the desired 
font. 

3.  Click the Font Size down-
arrow on the Formatting 
toolbar, and then select the 
size. 

 

Opens the Font Size list box, 
and then increases the font 
size. 

An example of a changed font: 

 

 
To quickly move to 
a particular font 
within the font drop 
down list: 
Click on the drop 
down arrow. 
With the list 
displayed, type the 
first letter of the 
font’s name.  
Scroll if needed. 
Click on the font’s 
name. 
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Step by Step - Apply Bold and Italic Styles 
 

 What you do What happens 

1.  Select the cell that you want 
to change.  

Selects the cells. 

2.  Click the Bold icon on the 
Formatting toolbar. 

  

Applies bold formatting to 
the selected cells. 

3.  Select the cell that you want 
to change.  

Selects the cells. 

4.  Click the Italics icon on the 
Formatting toolbar. 

 

Applies italic formatting to 
the selected cell. 

5.  To bold or italicize non-
connecting cells, click CTRL 
and click on the various 
desired cells to highlight them 
and then use the Bold or 
Italics icons.   
 
 
 

This will highlight the 
random cells to which you 
want your formatting applied. 
 

An example of Bold Formatting: 
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Step by Step - Change Text Color 
 

 What you do What happens 

1.  Select the cells that you want 
to make a font color change 
to.   

Selects the cells. 

2.  Click on the Font Color icon, 
then click the color of choice 

 

Opens the Font Color palette, 
and changes the color of the 
text in the selected cells to the 
chosen color. 

The Color Palette: 
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Step by Step - Apply a Single Border 
 

 What you do What happens 

1.  Select the cells that you want 
to add a border to.  

Selects the cells. 

2.  Click Format, then trace to 
and click Cells. 

Opens the Format menu, and 
then opens the Format Cells 
dialog box. 

3.  Click the Border tab. Reveals the Border card. 

4.  Click the desired Border 
icon(s) in the Presets area 
(None, Outline, or Inside) and 
the Border section. 

Applies a border to the 
bottom of the preview image 
in the dialog box, as shown 
below. 

5.  Select the Style of Border 
from the Line section. 

Applies the style to the border 

6.  Click the OK button. Closes the dialog box and 
applies a single border to the 
bottom of the selected cells. 

The Border Card with the Presets, Border and Style areas marked: 

 

Style

Border

Presets
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Step by Step - Apply Shading 
 

 What you do What happens 

1.  Press Ctrl+Home, and then 
click the Select All button. (It 
is the gray colored rectangle 
at the junction of the row and 
the column headers.)  
An alternative method is to 
press Ctrl +A. or select the 
cells that you want to shade.  

Moves to cell A1, then selects the entire 
worksheet or the cells highlighted. 

 
2.  Click Format, then trace to 

and click Cells. 
Opens the Format menu, and then opens 
the Format Cells dialog box. 

3.  Click the Patterns tab. Reveals the Patterns card. 

4.  Select the color you wish to 
use.  Select a pattern from the 
Pattern dropdown, if desired. 

Shows a preview of how the color will 
appear in the worksheet. 

5.  Click the OK button, then 
click cell A1. 

Closes the dialog and applies the color to 
the worksheet, then selects cell A1. 

The Cell Shading Color Palette and Patterns: 

 

 
After shading is 
applied to the 
worksheet, the 
gridlines are no 
longer visible. 



Excel 2003  The University of Akron 

 
Ver. 2005.11.30 Page 59 Information Technology Services 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

Step by Step - Create a Custom Footer 
 

 What you do What happens 

1.  Double-click on the View option 
from the Menu bar. 

Returns the Page Setup dialog 
box.  
 

 
2.  Click the Custom Footer button. Opens the Footer dialog box. 

 

 
3.  Type your footer in the Left, 

Center, and/or the Right sections 
list boxes.  

Enters the text. 
 

4.  If you want to add page numbers, 
then type Page in the Right 
section list box. 

Moves the insertion point to 
the Right section list box, and 
then enters the text. 

5.  Enter a space, and then click the 
Page Number icon. 

 

Enters a space after Page, and 
then inserts a placeholder for 
the page number. 

6.  Click the OK button in the 
Footer dialog box. 

Closes the Footer dialog box 
and displays the new footer in 
the Page Setup dialog box. 

7.  Click the OK button in the Page 
Setup dialog box. 

Closes the Page Setup dialog 
box and shows the worksheet 
in Print Preview. 
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An example of the entry for a custom footer: 

 

 

The header and footer will now show up on any new pages that 
are printed from the Sheet1 worksheet, but they will not appear 
on the other worksheets in the workbook.  To set headers and 
footers for the other worksheets, click the sheet tab for the 
worksheet you want to print, then open the Page Setup dialog 
box and use the Header/Footer card to apply headers and 
footers. 
If you want to use the same header or footer on more than one 
worksheet, first, select the worksheets you want to include.2 
Then, open the Page Setup dialog box and setup the header or 
footer. 

                                                 
2 To select more than one worksheet, hold down the CTRL key and click on the sheet tab for each of the 
sheets that you want to select. The sheet tabs will appear as active, in white. 
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Step by Step - Preview the Worksheet 
 

 What you do What happens 

1.  Click File, then trace to and 
click Print Preview. 

Opens the File menu, and 
then displays the worksheet in 
Print Preview mode.  

2.  Move the mouse pointer over 
the page. 

Changes the mouse pointer to 
a magnifying glass pointer. 

3.  Click the title (or anywhere) 
on the worksheet. 

Zooms in on the worksheet. 

4.  Click the worksheet again. Zooms out to a full-page 
view. 

5.  Click below the scroll box on 
the vertical scroll bar. 

Shows the contents of the 
second page. 

6.  Click the Close button on the 
Print Preview toolbar. 

Closes Print Preview and 
returns to the worksheet. 

An example of Print Preview: 
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Step by Step - Change Page Orientation and Scaling 
 

 What you do What happens 

1.  Click on the Print Preview 

icon in the toolbar  .  

The Print Preview view is 
displayed. 
 
If there is more than 1 page 
use the Next button on the 
toolbar to see the next page. 

2.  Click on the Setup button in 
the toolbar. 

This works the same as File, 
Page Setup to return the Page 
Setup dialog box. 

3.  Select the Portrait option in 
the Orientation section. 

Specifies that the page will be 
wider than it is tall. 

4.  Select the Fit to Option in 
the Scaling section. 

Specifies that the worksheet 
will be sized to fit on one 
page. 

5.  Click the OK button. Opens the Print Preview 
window and shows that the 
worksheet now fits on one 
page. 

6.  Click on the Close button or 
the Esc key to return to the 
sheet. 

The sheet displays. 

An example of scaling: 
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Step by Step - Set Page Margins 
 

 What you do What happens 

1.  Click File on the menu bar, 
then trace to and click Page 
Setup. 

Opens the File menu, and 
then opens the Page Setup 
dialog box. 

2.  Click the Margins tab. Reveals the Margins card. 

3.  Double-click in the Left text 
box, then type 1, or the 
desired spacing. 

Selects the text in the Left 
text box, and then sets the left 
margin to 1 inch. 

4.  Press the Tab key, and then 
type 1, or the desired spacing, 
in the Right text box. 

Selects the text in the Right 
text box, and then sets the 
right margin to 1 inch. 

5.  Click the OK button. Closes the Page Setup dialog 
box and shows the worksheet 
in Print Preview mode with 
new margins. 
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Step by Step - Adjust Centering 
 
 

 What you do What happens 

1.  Click File on the menu bar, 
then trace to and click Page 
Setup. 

Opens the File menu, and 
then opens the Page Setup 
dialog box. 

2.  Click the Margins Tab. Reveals the Margin Card. 

3.  Select the Horizontally and 
Vertically options in the 
Center on page section. 

Specifies that the worksheet 
will be centered on the page 
and adjusts the preview image 
to show the change. 

4.  Click the OK button. Returns to Print Preview and 
applies the changes. 

An example after adjustment for centering: 

 
 
 
 
 
 
 
 
 
 
 

A Reference Guide for Printing Large Worksheets  is provided in the Appendix of 
this manual.  
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Page Breaks 
 
Step by Step - Insert A Page Break 
You can insert page breaks to make the printed copy of the worksheet easier to read.  You 
must have a printer driver installed on your computer if you want to perform printing-
related tasks in Excel. 
 
New Terms 
Page Break Use page breaks to tell Excel which rows and/or 

columns are to be printed on a page. 

Page Break 
Preview 
Command 

Use the Page Break Preview command on the 
View menu to see how the pages and page breaks 
will be formatted when the worksheet is printed. 

 
 What you do What happens 

1.  Click the row heading where 
you wish to place the page 
break. 

Selects the row below where the page break will go. 

2.  Double-click Insert on the 
menu bar, then trace to and 
click Page Break. 

Displays the expanded Insert menu, then inserts the 
page break above the selected row. 

3.  Click View on the menu bar, 
then click Page Break 
Preview. 

Switches to Page Break Preview and opens the 
Welcome to Page Break Preview message box. 

4.  Click the OK button in the 
Welcome to Page Break 
Preview message box. 

Closes the Welcome to Page Break Preview message 
box and displays the worksheet showing the current 
page breaks, as well as the newly added page break, as 
shown in screen shot on the next page. 

 
5.  Click View on the menu bar, 

then trace to and click 
Normal. 

Returns the worksheet to the normal view. 
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The Page Breaks Inserted Above Row 20 

 
Step by Step - Move Page Breaks in Page Break Preview 
 

 What you do What happens 

1.  Click View on the menu bar, 
then click Page Break 
Preview. 

Switches to Page Break Preview and opens the 
Welcome to Page Break Preview message box. 

2.  To remove the extra page, 
(page 3 in our example), 
place cursor on vertical blue 
dotted line and drag to the 
right to meet the end of page 
3.   

Moves Page 1 and Page 2 horizontally, and removes 
excess pages of 3 and 4.   

3.  To adjust Page 1 and Page 2 
vertically, place cursor on 
solid horizontal line (at row 
20) and drag to above row 25.  

Moves Page 1 down to row 24 and Page 2 to start at 
Row 25.   

4.  Click View on the menu bar, 
then trace to and click 
Normal. 

Returns the worksheet to the normal view. 
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Step by Step - Remove A Page Break 
 
New Terms 
Remove Page 
Break 
Command 

Use the Remove Page Break command on the 
Insert menu to remove a page break from the 
current worksheet. 

 
 What you do What happens 

1.  Click the Print Preview 
button on the Standard 
toolbar. 

Opens Print Preview showing the first page of the 
worksheet. 

2.  Scroll down. Shows the second page of the worksheet. 

3.  Click the Close button. Closes Print Preview. 

4.  Click the row heading below 
where the page break will go. 

Selects the row below the page break. 

5.  Click Insert on the menu bar, 
then trace to and click 
Remove Page Break. 

Removes the page break from the worksheet, as shown 
in screen shot. 

6.  Click the Save button. Saves the workbook. 

 
The Worksheet After Removing The Page Break 
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Using Comments 
 
Step by Step - Add A Comment 

Comments are notes that you can attach to individual cells on a worksheet.  You can use 
them to provide instructions, to explain a particular section of a worksheet, or as a 
reminder.  Cells with comments have a small triangle in the upper-right corner.  When 
you place the mouse pointer over the cell, the comment appears in a text box next to the 
cell.  The name of the person who added the comment appears in the text box, so 
comments added by other users in a shared workbook are easy to identify. 
New Terms 
Comments Comments are notes that you can attach to 

individual cells on a worksheet.  Cells with 
comments have a small triangle in the upper-right 
corner.  Comments appear when you place the 
mouse pointer over the cell. 

Comment 
Command 

Use the Comment command on the Insert menu to 
begin entering a comment for the selected cell. 

 
 What you do What happens 

1.  Click the cell where you wish 
to add a comment. 

Selects the cell. 

2.  Double-click Insert on the 
menu bar, then trace to and 
click Comment. 

Opens the Insert menu, then shows a comment text 
box for the selected cell. 
 

 
3.  Type the comment in the 

comment text box. 
Enters the comment in the comment box. 

 
4.  If you select another cell, the 

comment will be hidden.  By 
default, a small red triangle in 
the upper right corner of the 
cell indicates the existence of 
a comment for the cell. 

Selects another cell and hides the comment. 
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5.  Place the mouse pointer over 
the cell where you just added 
the comment.  The comment 
will appear. 

Shows the comment for the cell, as shown in screen 
shot. 

 

 
The Comment Added To Cell J6 

 
To print the comments in a workbook, click File on the 
menu bar, then trace to and click Page Setup.  In the 
Page Setup dialog box, click the Sheet tab, then use the 
comments down arrow to select whether the comments 
will print at the end of each worksheet or as they are 
displayed on each sheet. 

 
You can also add a 
comment by right-
clicking a cell, then 
tracing to and 
clicking Insert 
Comment.
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Step by Step - Hide or Display Comments and their Indicators 
 

 What you do What happens 

1.  On the Tools menu, click 
Options, and then click on 
the View tab. 

Opens the Options dialogue box.  Displays the View 
tab. 

2.  To hide comments, even 
when you rest the pointer 
over the cells that contain 
them, and also clear the 
comment indicators in the 
corners of the cells, select 
None under Comments. 

3.  To display comments when 
you rest the pointer over cells 
that contain them, and also 
show the comment indicators, 
select Comment indicator 
only. 

4.  To display both comments 
and indicators regardless of 
mouse position, select 
Comments & indicator. 

The Option box: 

 
You can also hide 

an individual comment by 
right-clicking the cell, 
and then clicking on Hide 
Comment.   
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Step by Step - Edit A Comment 
 
New Terms 
Edit Comment 
Command 

Use the Edit Comment command on the Insert 
menu to begin editing the comment for the 
selected cell. 

 
 What you do What happens 

1.  Click the cell with the 
comment you wish to edit, 
double-click Insert on the 
menu bar, then trace to and 
click Edit Comment. 

Selects the cell, opens the Insert menu, then selects the 
comment box on the worksheet. 

2.  Edit the comment as needed. Modify the comment. 

 
The Edited Comment 

 
You can also edit a 
comment by right-
clicking the cell, then 
tracing to and 
clicking Edit 
Comment.
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Step by Step - Remove A Comment 
 
New Terms 
Comments 
Command 

Use the Comments command on the Clear 
submenu to remove comments from the selected 
cells. 

 
 What you do What happens 

1.  Click the cell which the 
contains the comment you 
wish to remove. 

Selects the cell. 

2.  Click Edit on the menu bar, 
trace to Clear, then trace to 
and click Comments. 

Opens the Edit menu, opens the Clear submenu, then 
removes the comment indicator from the cell. 

 
The Comment Removed From J6 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
You can also remove 
a comment by right-
clicking the cell, then 
tracing to and 
clicking Delete 
Comment. 
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Charts 
 
A chart is a visual representation of numeric values. Once a worksheet is finished, you 
can use it to generate charts. Excel can create dozens of different types of charts, 
including column, bar, line, pie, scatter, area, and surface charts. Displaying data in a 
well-designed chart can make the numbers more meaningful. 

Charts are an alternative way to communicate what 
the numbers in a worksheet are stating. Charts are 
effective for making comparisons, analyzing data, 
and showing trends. For example, you might include 
a bar chart in a report to show how this term’s 
enrollment compares to last term’s enrollment or you 
could create a pie chart that shows the percentage of 
students by declared major. 

To create a chart, you select the cells that contain the data you want to include in the 

chart, and then click the Chart Wizard tool  on 
the Standard toolbar to begin creating it. You can 
choose the type of chart you want, apply visual 
effects, add titles and data labels, and change colors 
and borders. If the data in the worksheet changes, 
the chart will automatically update to reflect the 
new information. 
 

There are two methods that can be used to create a chart in Excel: 
 Use the F11 key to create the chart on a separate worksheet 
 Use the Chart toolbar to create the chart on the same worksheet as the data  
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Step by Step – Create a Chart Using F11 
 
Here is a quick way to create a chart. Once the chart is created, you use the techniques 
reviewed later in this manual to modify the chart. 
 
 What you do What happens 

1.  SELECT THE DATA TO CHART. 
Click in the first cell  to include and 
drag to the last cell to select the range. 

The numeric data and the labels for the 
chart are selected. 

2.  PRESS F11. The chart is created on a separate sheet. The 
sheet is placed before the active sheet. 
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Step by Step – Create a Chart Using the Chart Toolbar 
 
Here is another quick way to create a chart. Once the chart is created, you use the 
techniques reviewed later in this manual to modify the chart. 
 
 What you do What happens 

1.  ENTER THE DATA. 
Click on the Sheet tab to make that sheet 
active. 

The Sheet is displayed. 

2.  DISPLAY THE CHART TOOLBAR. 
In the menu, click on View, Toolbars, 
Chart. 

The Chart toolbar is displayed. 

3.  SELECT THE DATA TO CHART. 
Click in the first cell and drag through 
the last cell to select the range. 

The data to chart is highlighted. 
 

4.  SELECT THE CHART TYPE. 
On the Chart toolbar, click on the down 
arrow of the Chart Type tool and select 
the type of chart you want. 
 

The Chart toolbar is shown with the chart 
types available on the Chart Type tool. 
 

 
In this example, the Pie chart was 
selected.  After the Pie chart is selected, 
Excel draws the chart on the same 
worksheet as the data. 

To reposition the chart, place the mouse 
pointer on the border of the chart and drag 
the chart to a new location. 
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Step by Step – Create a Chart with the Chart Wizard 
 
 What you do What happens 

1.  Use the mouse to select the 
range of cells to include in the 
graph. 

The cells in the range will be highlighted on the 
screen. This data will be included in the chart.  

 

2.  On the standard toolbar, click 
on the down arrow of the 

View tool  . 

The list of views is returned. 

 

3.  Click on the 75% view to 
select it. 

Specifies that the worksheet will be viewed at 
75% of the print size. 

4.  Click on the Chart Wizard 

tool  on the standard 
toolbar. 

tarts the Chart Wizard. Step 1 of 4, “Chart 
Type,” is returned. 

 



Excel 2003  The University of Akron 

 
Ver. 2005.11.30 Page 77 Information Technology Services 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

5.  Note that there are two pages 
in the Step 1 box, Standard 
Types and Custom Types.  
 
Select the desired chart type. 

The “Pie with a 3-D Visual Effect” is selected 
as the Chart Type. 

 

6.  Click and hold down the 
mouse button on “Press and 
Hold to View Sample”. 
 
This allows you to see a 
sample of the chart of your 
selected data. 
 

A sample of your chart is displayed. 
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7.  Click on the tab for “Custom 
Types” to view that page of 
the Chart Type box. 
 
You can preview the various 
charts by clicking once on 
each of the choices in list.   
 

The B&W Pie previewed 

 

8.  Click on the Standard Types 
tab to return to the first page 
of the box.  
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9.   Click the Next button. Advances to Step 2 – Chart Source Data of 
the Chart Wizard. 

 

10.  Note that there are two pages 
in the Chart Source Data box: 
Data Range and Series.  

Verifies that the correct data will be charted.   
 
If you need to select a different range: 

1. Click the Expand/Collapse  
button to the right of the Data 
Range text box. 

2. Select the correct range. 
3. Click the Expand/Collapse button 

to return to the wizard. 
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11.  In this particular example, we 
will verify that the Columns 
option is selected in the 
Series in section.  
NOTE: The cell references in 
the Data Range text box are 
absolute.  The chart will 
always refer to that range of 
cells, even if the data is 
moved to a different location 
on the worksheet. 

Specifies that the series of data in the selected 
range be contained in columns. 

 

12.  Click on the folder table for 
the Series page. 
 
On this page, you may add or 
modify the series of data that 
is being charted.  
 
In a pie chart there is only 
one series of data, but in 
many other chart types you 
may have several data series.  
For example, in a column 
chart there could be a series 
of expenses for January, a 
second series of expenses for 
February, etc. 

The Series page of the Chart Source Data box 
is displayed. 
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13.  Click the Next button. Advances to Step 3 – Chart Options of the 
Chart Wizard. 

 

14.  The Chart Options box for the 
pie chart has three pages: 

 Titles 
 Legend 
 Data Labels 

To enter the chart title, click 
inside the Chart title text box 
and type the title for your 
chart. 
 

Places the insertion point in the Chart title text 
box and enters the text.  The preview image is 
updated to reflect the title. 

 
 

15.  Click on the Legend tab.  The Legend page is displayed. 
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16.  Select the appropriate text 
box to remove the legend or 
to change the placement of 
the legend.  

In this example, the Legend is removed form 
the chart. 

  

17.  Click the Data Labels tab.  The Data Labels page is displayed.  

 

18.  You can make the desired 
selections to change the label 
to: show the series name, 
category name, value, or 
percentage.   

In this example, the label has been changed to 
show a percentage and the legend key is 
selected. 
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19.  Click the Next button. Advances to Step 4 – Location of the Chart 
Wizard, which determines where the chart will 
be placed in the workbook. 

 

20.  Make the appropriate 
selection to either create the 
chart as a new worksheet or 
to create the chart as an object 
and choose the location. 

In this example, the sheet is saved as an object 
in Sheet 1 of the current workbook. 

 

21.  If you wish to adjust the 
location of the chart, with the 
mouse pointer on the border 
of the chart, drag and drop the 
chart to the desired location 
on the sheet.  

Example of the repositioned chart: 

22.  If you wish to revise your 
chart, be sure that the Chart is 
selected. When a Chart is 
selected, the file handles are 
visible. 
To select a Chart, click in the 
white area of the chart. 
(When your mouse pointer is 
in the white area of a chart, 
the Tip says “Chart Area.”) 

The file handles are displayed.  The Chart is 
selected. 
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23.  From the menu, click on 
Chart. 
 
To revise or add your choices 
in the Chart Wizard, choose 
the step that you need. 

The Chart menu is displayed. 

                                                

 

Note that these four 
choices are the four 
steps of the Chart 
Wizard  



Excel 2003  The University of Akron 

 
Ver. 2005.11.30 Page 85 Information Technology Services 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

Using Help 
A valuable tool when working with Excel is Help.  There will be times when you cannot 
figure out how to accomplish a task in Excel.  One of the best ways to seek help is to use 
Excel’s built in Help System. 
 
Option 1:  Using Help Box 

What you do What happens 

1. At the top of the Excel window, 
you will see the Help box.  It 
appears as follows: 

 
 

 

2. You can enter a word or phrase for 
the question that you have.  
 

 

3. For example, if information on 
formulas is needed: 

 
 

 
After you enter the word or phrase, 
press the Enter key. 
 

The Search Results task pane displays. 

 
 

4. Notice that there are different types 
of help files.  Some are actual 
templates, there are tutorials, there 
are step by step instructions, etc. 
 
Click on the item that you want to 
open in a new window. 
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Option 2:  Using Excel Help Task Pane 
What you do What happens 

1. From any task pane, use the down 
arrow at the task pane title bar and 
select Help from the drop down 
list. 
 

The Help task pane displays. 

 
 

2. In the Search for field, enter the 
word or phrase that you would like 
to research. 
 
Click on the Start searching  
button. 
 

The Search Results task pane displays. 

 
 

3. Click on the item that you want to 
open in a new window. 
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To Sum a Column of Values 
1. Click in the cell in which to enter the 

formula. 

2. Click on the AutoSum  tool on the 
standard toolbar. 

3. The formula will be displayed. 
Example: =SUM(F4:F9) 

4. Click on the green checkmark  on 
the formula toolbar. 

How does Excel determine the cells to 
include in the formula? Excel knows only 
two types of cell content, values and labels 
(non-values). Excel reads up from the 
active cell, looking for values. As soon as 
it finds a cell that contains a label (non-
value), it stops. Only, the cells with values 
are included in the AutoSum formula. 

The SUM Function 
AutoSum can be used to create a formula that sums the values in a range of cells. Sometimes, it may be preferable to 
enter the formula manually. To type the formula: 

1. Type an equal sign. 
2. Type the word sum. 
3. Type a beginning parenthesis. 
4. Type the name of the first cell in the group of cells.  
5. Type a colon : . 
6. Type the name of the second cell in the group of cells. 
7. Type an ending parenthesis. 

Order of Precedence 
The order of precedence is the order in which Excel calculates a formula. A suggested acronym to help 
remember the order of precedence is PEMDAS. In each step, Excel will begin at the left of the formula 
and move to the right. 
1. Parentheses – All calculations inside parentheses are performed first. 
2. Exponents – All values with exponents are calculated. 
3. Multiplication and Division – Any multiplication or division is performed. 
4. Addition and Subtraction – Any addition or subtraction is performed. 

=sum(b4:e4) 

Formula Basics 
A formula is a mathematical equation that 
calculates new values from existing values. In 
Excel, each formula should begin with an 
equal sign. The common operators used in 
formulas are: add (+), subtract (-), multiply (*), 
divide (/). As a rule, formulas do not contain 
spaces. When a formula is entered in a cell, the 
content of the cell is the formula. The value 
seen (the results of the formula) is displayed, 
but is not the content of the cell. 

content of cell results of formula 
 

 

Sample Formulas 
=B7+C7+D7+E7 Sums the values of 

the 4 cells. 
=sum(b7:e7) Sums the values of 

cells b7 through e7. 
Sum is a function. 

=g64-g65 Subtracts the value 
in g65 from the 
value in g64. 

=(e200/12) *.15 Divides the value in 
e200 by 12. Then, 
multiplies that 
answer by .15. 

=(f24*c10)-(f25*c10) 
First, multiples the value in f24 by the 
value in c10.  
Second, multiples the value in f25 by the 
value in c10.  
Third, subtracts the second value from 
the first value. 
 
When typing a cell reference, you can 
use upper and/or lower case. B7 and b7 
mean the same to Excel. Read as “equals sum b4 through e4.” 
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Function Basics 
A function has three parts: 
a. Equal sign 
b. Function name 
c. Argument, enclosed in parentheses 

=average(f4:f9) 

There are no spaces in the 
formula.

Help with Excel Functions 
From the menu, click on Help, Microsoft 
Excel Help. In the Search box, type functions 
and click on the Search button. 

Ranges 
Many formulas contain ranges, which are 
groups of cells that have common boundaries 
and form a rectangle in shape. Ranges may 
contain cells in a single row, a single column or 
may span several rows and columns. When 
typing a range, the range name is from the top 
left cell reference to the bottom right cell 
reference. A colon is entered between the first 
and the second cell reference. The colon is read 
as “through.” Some examples of ranges are: 

G4:G9 (G4 through G9) 
B4:E9 (B4 through E9) 

Examples of Functions to Count 
COUNTA Use this function to count the 
number of cells that contain data (are not empty) 
in the range specified within the parentheses.  
Example:  =COUNTA(A2:A653) 
COUNT This function counts the number 
of cells that contain numbers (including values 
that are the result of formulas), dates or numbers 
stored as text in the range specified within the 
parentheses. Example:  =COUNT(C2:C653) 
COUNTIF Use this function to count the 
number of cells in the range specified that meet 
the criterion. The example formula would count 
the number of cells in the range E2 through E 653 
that have the contents M. 
Example: =COUNTIF(E2:E653,“M”)  

Additional examples of COUNTIF: 
=COUNTIF(C2:C653,“>=3.25”) This formula 
counts the number of cells within the range that 
have a value greater than or equal to 3.25. 
=COUNTIF(A2:C200,“”) This formula counts 
the number of cells within the range that have 
no data. There is no character, no space 
between the quotation marks. 

Help with Formulas 
From the menu, click on Help, Microsoft Excel 
Help. In the Search box, type examples of 
formulas and click on the Search button. 

3-D Formulas 
With multiple worksheets, some of the 
formulas may include values that are stored on 
different worksheets. A formula that references 
cells on more than one worksheet is using 3D 
references. The formula is called a 3D 
formula. In a 3D formula, the cell reference 
will include the sheet name. For example, this 
formula sums the monthly totals for Richards, 
which are on sheet1 in cell B4, on sheet 2 in 
cell B4 and on sheet 3 in cell B4. 
  =sheet1!B4+sheet2!B4+sheet3!B4 
In a 3-D formula, a cell is referenced by its 
sheet and cell name. Sheet1!B4 is cell B4 on 
sheet1. An exclamation point is used to 
separate the sheet name from the cell name. 
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Freezing Rows and Columns 
When scrolling, the columns or rows of 
data needed to identify the records may 
scroll off the screen. Freezing will leave 
those identifying columns and rows in 
place as you scroll.  
1. Choose the active cell so that the rows 

above and columns to the left are those 
to freeze. Click in the cell to make it 
active. 

2. From the menu, click on Window, 
Freeze Panes.  

3. Scroll down to note that the rows stay 
visible above the cell selected in step 
one. Scroll to the right to note that the 
columns stay visible to the left of the 
cell selected in step one. 

4. From the menu, Window, Unfreeze 
panes to return to normal scrolling. 

Sorting Data in Lists 
1. Click anywhere inside the data to select an active cell.  
2. From the menu, select Data, Sort. The Sort dialog box appears. Excel will recognize and 

highlight the range of cells to use for the sort. (Do not select (highlight) any of the columns, 
rows or cells yourself. If you do, only those highlighted cells are sorted, not the rows, and your 
data will be scrambled.) 

3.  In the Sort dialog box at the down arrows, select the fields by which to sort. For each field, 
select to sort by ascending or descending order. 

4. In the “My list has” frame of the Sort dialog box, click to select Header row, if the first row of 
data contains the field names. Then, click on OK. 

To Delete a Column 
Select the column to be deleted by clicking on 
the column header. The entire column will be 
highlighted. From the menu, click on Edit, 
Delete. If a column is deleted in error, click on 
Edit, Undo in the menu. 

To Change the Width of All the 
Columns 
This will make each column as wide as 
its widest entry. Select all the columns 
by clicking on the gray rectangle above 
the row 1 header and to the left of the 
column A header. All the columns and 
rows are highlighted. Place the mouse 
pointer on the right border of the column 
header for column A. With the mouse 
appearing as a double-headed arrow, 
double click. 

Excel’s Rules for Lists 
1. Within the rows of data, there should be no completely blank rows and no completely blank 

columns. A null field value (a field with no value) is allowed. However, a row with no record or a 
column with no field values and no field name is not allowed. 

2. The row directly above the first row of data contains the field names. 

To Filter a List 
1. Click anywhere inside the data to select an active 

cell. 
2. From the menu, click on Data, Filter, AutoFilter. 

A down arrow will appear at the top of each row 
in the cell with the field name. (The arrows do not 
print.) 

3. Set the criteria by making choices at the lists on 
the down arrows. 

4. To remove the filter and view all the records, click 
on Data, Filter, Show All from the menu. 

5. To remove the filter arrows, click on Data, Filter, 
AutoFilter to remove the checkmark. 
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Printing a Large Worksheet in Excel  Quick Reference Guide 
From the menu, click on File, Page Setup. Follow any or all of these tips. Then, click on OK. 
 
 
 

Print the Field Names as a Header Row on 
Each Page 
This is done only one worksheet at a time. 
1. On the Sheet tab, click on the 

Expand/Collapse button  for Rows to 
repeat at top. The dialog box collapses 
to allow a better view of the worksheet. 

2. In the worksheet, click on the row 
number for the row which contains the 
text to repeat on all applicable pages. The 
row is surrounded by the marquee 
(dashed, moving lines). 

3. Click on the Expand/Collapse button to 
expand the dialog box.

Print the Row and Column Headings  
of the Worksheet 
Row headings are the row numbers and 
column headings are the letters. Printing these 
is helpful when each record has many 
columns and the record prints across several 
pages. The row numbers help to identify a 
specific record as you read across the pages. 
 
In the Print frame, click to place a checkmark 
in the Row and column headings checkbox. 

Print the Gridlines 
The gridlines are the lines that outline each 
cell. Although the gridlines are displayed on 
the screen, they do not print unless you request 
that they print. 
 
On the Sheet tab and in the Print frame, click 
to place a checkmark in the Gridlines 
checkbox. 
 
NOTE: Gridlines will not print if “Draft 
quality” is checked. 

Print Over, then Down 
By default, Excel prints as many rows and their 
related columns, as fit on one page. Then, it 
moves down the worksheet to print the next set 
of rows. Example: If there are 50 rows with 16 
columns in each row, rows 1 through 25 may 
print with their first 8 columns on page one. 
Then, Excel will print rows 26 through 50 with 
their first 8 columns on page two. It probably is 
preferable to print rows 1 through 25 with their 
first 8 columns on page one and rows 1 through 
25 with their next 8 columns on page two. This 
is referred to as “printing over, then down.” 
 
On the Sheet tab and in the Page order frame, 
click on the option button for Over, then 
down. 

Page Numbering 
1. Click on the Header/Footer tab. 
2. Click on the down arrow for the Footer 

edit box. A list of footers, which come 
with Excel, is displayed. 

3. Choose a footer, such as Page 1. This 
will print the word “Page” and the 
appropriate page number. 

Format Multiple Worksheets 
Changes made in the Page Setup dialog box will affect only the active worksheets. The tabs for 
active worksheets are white in color. To make changes on more than one worksheet, hold down 
the CTRL key and click on each worksheet tab before you select File, Page Setup. When the 
changes are completed, click on a worksheet tab for a worksheet that is not displayed on top.


